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WebScope is a web-based, platform-independent eSlide viewer that you can access from any workstation, 
including Macintosh or Linux, with an Internet browser and Adobe Flash Player. 

WebScope offers a rich set of features that enhance your eSlide viewing, such as:

`` eSlide annotations – Create and view annotations on the eSlide to emphasize the slide image or to identify an area 
for analysis using Aperio ePathology image analysis algorithms. See “Prerequisites and Compatibility” on page 
6 for information on user permissions needed to create or save annotations.

`` Analyze eSlides –  Analyze regions of the eSlide or the entire eSlide using Aperio image analysis algorithms. See 
“Chapter 5: Analyzing eSlides” on page 26 for details. Also see “Prerequisites and Compatibility” below for 
information on scenarios in which you cannot analyze eSlides.

`` eIHC Quick Analysis – Quickly and easily mark and analyze tumor regions using the appropriate algorithm for the 
eSlide’s stain and body site.  See “Chapter 4: eIHC Quick Analysis” on page 22  for details.

`` Clinical View – Access the clinical view for just the tools and functionality needed for a clinical workflow. See 
“Using Clinical View” on page 12 for details

`` Adjust brightness and contrast – By adjusting the brightness and contrast of the eSlide view, you can adjust the 
look of the eSlide to suit your preferences. For details, see ““Adjusting Brightness and Contrast” on page 11.

`` Navigate the eSlide – You can use multiple tools to zoom in and out and move around the eSlide. See “Depending 
on the type of eSlide you are viewing, the Information window can contain:” on page 10 for details.

Intended Use
For research use only. Not for use in diagnostic procedures.

Installation
WebScope is automatically installed with:

`` eSlide Manager – The eSlide management system manages all your eSlides as well as the associated information, 
such as case, project, specimen, and analysis information. eSlide Manager uses the Aperio ImageServer to view 
and store the eSlide images.

`` ImageServer Gallery – When accessing ImageServer directly on a Digital Slide Repository, a gallery of eSlides 
displays. Each eSlide contains links to open either with WebScope or ImageScope.

1 Overview
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Prerequisites and Compatibility
This section contains notes on requirements and compatibility.

Internet Browser Compatibility

The following Internet browsers are supported for use with WebScope:

`` Microsoft Internet Explorer versions 7, 8, and 9

`` Mozilla Firefox versions 2, 3, and 12

Adobe Flash Compatibility

WebScope is a Flash application. You must have Adobe Flash Player version 8 or later installed as an Internet browser plug-
in.

User Permissions 

The user role associated with your eSlide Manager login defines your user privileges in eSlide Manager and WebScope. To 
create and save annotations or to run analysis on eSlides, your eSlide Manager user role must contain these permissions. 
If your user role does not include these permissions, these features are not available to you in WebScope. For more 
information on your user role, consult your eSlide Manager administrator.

Monitor Recommendations

Because Aperio eSlides are by design high resolution and information rich, for best results you should use a high quality 
monitor to view them. Make sure the monitor is at the proper viewing height and in a room with appropriate lighting. 
We recommend any high quality LCD monitor meeting the requirements recommended in the Aperio ePathology System 
Requirements.
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Quick Tour of WebScope 
The WebScope main window displays the eSlide. The WebScope window also contains a menu bar, a main toolbar, the 
thumbnail image, and a zoom slider. 

Toolbar

Zoom slider

ThumbnailWebScope main window pane

Main Window Icons

Icon Description For more, see…

Indicates that an Integrated Color Management color 
profile was embedded in the image when the slide was 
scanned and that the profile is being used to adjust the 
view of the image. The icon displays at the top of the 
WebScope window.

ImageScope User’s Guide for information 
on the benefits of Aperio Integrated Color 
Management.
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Main Toolbar Icons - Standard View

Icon Description For more, see…

Pin or unpin the menu bar “WebScope Menu Bar” on page 8

Show/hide thumbnail “Navigate with the thumbnail window” in the table on 
page 8

Show/hide zoom slider “Change the magnification” in the table on page 11

Adjust brightness/contrast “Adjusting Brightness and Contrast” on page 11

Show/hide Annotations window “Chapter 3: Using Annotations” on page 15

Analyze the eSlide “Chapter 5: Analyzing eSlides” on page 26

Save annotations “Chapter 5: Analyzing eSlides” on page 26

Pan - move the image in the WebScope window “Move around the eSlide” in the table on page 10

The following tools are used to draw annotations. For details, see “Chapter 3: Using Annotations” on page 15.

Keyboard Shortcuts

To ensure that the keyboard shortcuts are used by WebScope rather than your browser, click on the WebScope main window 
to set focus on that window before using a shortcut.

Key Description

F11 key Turn full screen display on and off.

H key Show or hide annotations

Control G Show or hide Analysis window

Control A Show or hide Annotations window

A Zoom in

Z Zoom out

WebScope Menu Bar

When the menu bar is open, it appears beside the toolbar.

To keep the menu bar open every time you open WebScope, click the push-pin button . The button changes to indicate 
the menu bar is pinned . 
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The WebScope menu bar is hidden by default. Click the arrow button to open or close the menu bar.

Note that if you are using clinical view, the toolbar contains just those tools used in the clinical workflow. See “Using 
Clinical View” on page 12 for details.

You can right-click in the WebScope window to access a shortcut menu that contains many of the 
same features available from the toolbar. 

Opening eSlides in WebScope
The method for opening the eSlide differs depending on the Aperio product you are using with WebScope:

If you are using: You open WebScope like this:

eSlide Manager without ImageScope 
installed on your workstation

Go to an eSlide page and click the thumbnail image.

eSlide Manager with ImageScope 
installed

When ImageScope is installed on your workstation, the eSlide automatically 
opens in ImageScope. 

To open the eSlide in WebScope, press the W key on your keyboard while 
clicking the thumbnail image in eSlide Manager.

ImageServer When accessing ImageServer directly on the eSlide Repository, a gallery of 
eSlides appear with links for WebScope and ImageScope. 

Click the WebScope link under the eSlide or the thumbnail image.

Note: WebScope requires that you have Adobe Flash Player installed. If you do 
not have Adobe Flash Player, a message appears asking if you want to install it. 
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Viewing Information on the eSlide

To view information on the eSlide, go to the Image menu and select Information. 

Depending on the type of eSlide you are viewing, the Information window can contain:

`` The eSlide image ID (@xxxx) used to identify the eSlide image by Aperio ePathology software.

`` Information on the eSlide image.

`` The entire eSlide, the portion of the glass slide that was scanned. 

`` The macro image, the image of the entire glass slide from which the scan was made.

`` The label that was scanned from the glass slide.

Navigating in WebScope
WebScope has many tools for navigating the eSlide image.

To do this: Do this:

Move around the eSlide yy Click inside the eSlide image and hold down the mouse button while dragging 
the image. (If another tool is selected, click the  button.)

yy Use the arrow keys on your keyboard to shift the image in different directions. 
(Hold down the Shift key to move a greater distance.)

Navigate with the thumbnail 
window

(The example on page 7 shows 
the location of the thumbnail 
window.)

Do the following:

yy Click inside the thumbnail window 
to move to the corresponding 
location on the eSlide.

yy Drag the box to change the view 
in the Viewer window.

Click  to show or hide the Thumbnail 
window.
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To do this: Do this:

Change the magnification To quickly zoom to the maximum magnification, double-click with the cursor on the 
image in the main window.

Use the Zoom Control to select a 
magnification of Fit, 1x, 2x, 4x, 10x, 
20x, or higher, depending on your 
scanner and the scan magnification 
used.

Select Fit to display the entire eSlide 
in the Viewer window.

Zoom using the keyboard Press the A key to zoom in, and press the Z key to zoom out.

Adjusting Brightness and Contrast
You can adjust the brightness and contrast to an eSlide for the current viewing session. The changes you make are not 
saved with the eSlide image. (To make permanent changes, use the Digital Slide Studio application.)

To adjust the brightness and contrast of the eSlide image:

1.	 Click  on the toolbar or go to the Image menu and select Adjustment. 

2.	 When the Color Adjustment window appears, adjust the brightness or contrast by moving the corresponding 
sliders. 

3.	 After making your adjustments, you can:

`` Click Compare to view the image without the adjustments.

`` Click Apply to apply the changes or Cancel to exit without making the changes.
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Using Clinical View
To optimize WebScope for clinical use, select Clinical Toolbar from the View menu. The clinical toolbar contains only the 
tools needed for drawing tumor regions and selecting a report image:

When using clinical view, you use the Summary View of the Annotations window to analyze eSlides. See “Chapter 4: 
eIHC Quick Analysis” on page 22 for details.

The eSlide Manager user settings determine whether the clinical or standard toolbar appears when you open WebScope. To 
changes these settings, contact your eSlide Manager administrator.

To return to the standard WebScope toolbar, go to the View menu and select Standard Toolbar.

Creating Bookmark Links
You can create a link to send to others that opens a specific eSlide in ImageScope or WebScope.  

With the eSlide open in WebScope, go to the Image menu and select Custom Bookmark. When the link page appears, 
you can copy and paste the link for ImageScope or WebScope.  

For WebScope links, select the options you want to make available to your recipients: 

`` Display navigation window (thumbnail)

`` Display toolbar 

`` Display menubar

`` Display annotations
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You can set the WebScope options for magnification and analysis, report images, and annotations. 

Access WebScope Options
To access the WebScope options, go to the Tools menu and select Options. 

2 WebScope Options
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Setting the General, Report Image, and Annotations Options

The following table describes the tabs available from the Options window:

Options tab Description

General The General tab contains magnification and analysis options.

The Magnification options are:

`` Initial Magnification – The magnification for images when they are first opened. Specify 
from 1 to 100 percent, or 0 to fit the entire eSlide in the main window.

`` Maximum Magnification – Specifies how far you can zoom into the image. Note that if 
you use a value greater than 100%, the image resolution does not change.  

`` Use “X” magnification rather than “%” – The zoom slider displays magnification 
as “2x,” 4x,” and so on, using the same terminology as a microscope objective. 
X-magnification is turned on by default. To use percentages, clear this check box. 

The Generate Markup Images check box in the Analysis section enables you to always generate 
a markup image when you run an analysis. The markup image is a visual representation of the 
quantitative data. (If you do not select this option, you can still create a markup image when you run 
the analysis. See “Running an Analysis” on page 27.)

Report Image These settings provide a combination of fixed or selectable sizes and resolutions for the report 
images you create. (See “Selecting eSlide Manager Report Image” on page 16 for information 
about report images.)

If you press and hold the Control key when drawing a report image, WebScope creates the image at 
a specific size. The Fixed Region Size determines the size of that report image. 

Other options on this tab determine the resolution of the report image:

`` The full resolution options capture the report image at 100% magnification even if you are 
viewing the slide at a different magnification.

`` The current resolution options capture the report image at the magnification you are using 
to view the image.

Annotations The Default Annotation Colors options enable you to change the color used for each annotation 
layer. Click the colored box above the annotation layer. When the color window appears, select a 
color box or enter a standard hexadecimal code used for web color palettes. You can define up to 
five colors. If you use more than five annotation layers, the colors start over at Layer 6.

If you press and hold the Control key when drawing certain annotations, WebScope creates the 
annotation at a specific size. The Fixed Size Regions options define the width and height of 
rectangle and circle annotations, and the length of ruler and arrow annotations.
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Use annotations to define a region of interest on the eSlide, measure an object, or indicate an interesting area that you 
want to highlight. You can also use annotations to define the areas of the eSlide on which to perform or not to perform an 
algorithm analysis.

Summary and Detailed Views
This chapter discusses using the Annotations window in detailed view. 

If the Summary button appears on the window, you are in detailed view.

If the Details button appears, you are in summary view, which is used for quick 
eIHC analysis. For details on summary view and eIHC analysis, see “Chapter 
4: eIHC Quick Analysis” on page 22.

To go to the detailed view, click the Details button. 

Note: If you do not see the Details button, this means you are in clinical viewing 
mode. For more information, see “Using Clinical View” on page 12.

Annotation Drawing Tools
The annotation drawing tools are located on the main toolbar.

3 Using Annotations
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The following table describes how to use each tool:

Tool Description

Pen Draw a freehand annotation. Freehand annotations are often used to identify tissue of interest to 
analyze.

Negative Pen Draw an area to exclude from analysis.

Ruler Draw to measure a slide feature. 

If the image was not created by an Aperio scanner, the unit of measure may be pixels instead of 
microns or millimeters. You can set the image resolution in ImageScope so that the WebScope 
ruler displays measurements on these images in microns or millimeters. See the ImageScope 
User’s Guide for details.

Rectangle Draw a rectangle. Rectangles are often used to identify an area of the eSlide to analyze. To draw 
a square, hold down the Shift key while you draw.

Ellipse Draw an elliptical annotation. Hold down the Shift key while you draw to draw a circle.

Arrow Draw an arrow to draw attention to a slide feature. Place your cursor on the image in the main 
window close to the object you want to point at, click and drag away from it. The further you drag, 
the larger the arrow appears.

Report image Select an area to include in a eSlide Manager report. (See the eSlide Manager Reporting User’s 
Guide for information on the optional reporting product.)

You can also access the annotation tools by right-clicking and selecting the tool from the shortcut 
menu, or by going to the Tools menu, selecting Drawing, and selecting the tool you want to use.

Drawing Annotations

To draw an annotation on the eSlide, click one of the drawing tools on the main toolbar, left-click, and move across the 
eSlide in the main window. You will see the annotation on the eSlide. For example, the pen and arrow were used on the 
eSlide below:
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Selecting eSlide Manager Report Image

A Report Image is captured from an eSlide or specimen, and can be included in eSlide Manager reports that include the 
associated eSlide or specimen.  

With the eSlide or specimen image open in WebScope, click the  icon on the main toolbar, and then click to select an 
area of the eSlide to display in a report. The area selected is saved as an annotation with the text label “Report Image.” You 
can have only one report image on an eSlide, and the report template used must contain images in order for this image to 
display.

To draw an area of a fixed size, hold down the Control key while you draw. See“Report Image” in the table under “Setting 
the General, Report Image, and Annotations Options” on page 14 for information on setting the fixed size of a report 
image.

Using the Annotations Window
To open or close the Annotation window, click .  

The Annotations window shows information about the annotations you have drawn. For example, the Annotations window 
below shows the length and area in microns of two annotations drawn using the pen and negative pen drawing tools.

 

If the resolution of the image is not known, measurements in the Annotations window appear in 
pixels rather than in microns. You can use ImageScope to set the image resolution so that WebScope 
knows the microns per pixel measurement for the image, and can display microns. For details, see the 
ImageScope User’s Guide.
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Arranging the Annotations Window

You can move the panes of the Annotation window to suit your preferences, choose a vertical or horizontal arrangement, 
and select whether you can see the eSlide behind the Annotations window.

Header Header

Moving pane boundaries To rearrange a pane, place your pointer on a pane boundary until you see the  
symbol, then drag the boundary:

Change the orientation To set the Annotations window into either a vertical or horizontal configuration, 
click  or  at the top of the Annotations window.

Setting transparency If you want to see through the Annotations window, click the Transparency icon 
 at the top of the window. Click it again to make the window opaque.

Enabling/Disabling Annotations
To enable or disable annotations, go to the View menu and select Disable Annotations. When annotations are disabled, 
all annotations disappear and a warning symbol appears over the Annotations icon on the toolbar: . You cannot create or 
save annotations in this mode. 

To enable annotations after disabling them, click  on the toolbar.

Working with Layers and Attributes

Each group of annotations can exist on a separate layer. This allows you to organize information and related annotations by 
doctor or department or by category. For example, one layer of annotations may be drawn by Dr. Garcia, while another layer 
of annotations may be drawn by Dr. Edwards. When you analyze the eSlide, the image analysis results appear in another 
layer.

Each layer uses a different color so that you can tell one from another on the eSlide image. (To change the colors, see 
“Annotations” in the table under “Setting the General, Report Image, and Annotations Options” on page 14 for details.)

Each layer can have one or more attributes. An attribute can simply be text stored with that layer. For example, you can add 
manual scores to an annotation. See “Adding Layers, Layer Attributes, and Region Attributes” on page 20  for details.
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Showing/Hiding Layers and Viewing Annotations

To make an entire layer visible or invisible on the main window:

1.	 Click to select a layer in the Layers pane.

2.	 Click . (When this button is down, the annotations in that layer are visible; when it is raised, the annotations are 
not visible).

You can also press the H key on your keyboard to make all annotations visible or invisible.

To see an annotation centered on the eSlide image, click that annotation’s Region number in the Layer Regions 
area of the window.

Renaming Layers and Attributes

By default, WebScope uses simple names like Layer 1 to identify layers and attributes. To change the name, double-click the 
layer.  When it is highlighted, as shown below, type a new name:
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Adding Layers, Layer Attributes, and Region Attributes

You can create your own layers, layer attributes, and region attributes. (Region is another word for annotation.) You may 
find this useful for organizing information about the eSlide and for separating annotations made by people in different 
departments.

To add a new layer:

1.	 Click  in the Layers pane and a new layer appears in that pane. 

2.	 To change the name of the new layer, double-click on its default name and type a new name.

To add a new layer attribute or region attribute:

1.	 Click the  button in the Layer Attribute or Layer Region area of the Annotations window. A new window pops up 
when adding layer attributes and region attributes asking for the name of the new attribute.

2.	 Click Apply to add the new attribute or Cancel to exit back to the Annotations window.

Adding Text Labels

To add a text label to an annotation in the WebScope image display:

1.	 Go to the Layer Regions pane in the Annotations window.

2.	 On the line for the annotation you want to label, double-click the field in the Text column and type the text for the 
label.

The text label appears on the eSlide image:
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Changing Layer Colors

To change the color of a layer (this changes the color used to display the annotations in that layer on the eSlide image), 
select the layer in the Layers pane of the Annotation window. Click the color box in the Layers pane to select a new color.

Deleting Layers, Layer Attributes, Region Attributes, and Annotations

WebScope provides many different ways to delete annotations, layer attributes, and region attributes:

To delete: Do this:

A single layer Select the layer in the Layers pane and click the  button in that pane.

All layers Click the  button in the Layers pane.

A layer attribute Select a layer in the Layers pane. Click the attribute you want to delete and click the 
 button.

A region attribute Select a layer in the Layers pane, select the attribute in the Layer Region pane, and 
then click the  button.

A region (annotation) Select the region in the Layer Regions pane, and click the  button in that pane.
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This chapter discusses how to use the eIHC feature to mark tumor regions and analyze IHC eSlides in one 
easy step.

The WebScope detailed Annotations window provides a general solution for image analysis and handling annotations. 
However, a more streamlined version of the Annotations window is also available—the Annotations summary view. The 
Annotations summary view was specifically developed for analyzing IHC eSlides, and makes the process quicker and simpler 
by fitting into a pathologist’s or researcher’s standard workflow. 

For details on using the eIHC features and on eIHC setup steps for eSlide Manager, see:

`` eIHC User’s Guide

`` eIHC Guide to eSlide Manager Setup Guide

`` The user’s guide for the specific eIHC application you are using

Slide-Specific Processing
The key to the eIHC workflow is slide-specific processing, which defines how the eSlide will be processed based on its stain 
and type of tissue (body site). Slide-specific processing can define what algorithm is used to analyze that type of slide, how 
analysis results are displayed and how to interpret those results (alternatively, manual scoring can be set up for the slide), 
and what comments are available for use by the pathologist or researcher viewing the slide. The slide-specific configuration 
for each stain/body site combination is defined by the eSlide Manager administrator. Once slide-specific processing is set 
up, viewing, annotating, and analyzing the eSlide becomes a quick process. See the eIHC Guide to eSlide Manager Setup 
Guide.

The summary view of the Annotations window is designed specifically for working with IHC eSlides to provide a quick way 
to mark tumor regions and analyze them in one simple step.

4 eIHC Quick Analysis
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Using the Annotations Summary View Window
To open the Annotations window in summary view:

1.	 Identify an eSlide in eSlide Manager for which stain/body site slide-specific processing is defined.

2.	 In eSlide Manager, open the eSlide in WebScope by clicking its thumbnail. (If ImageScope is installed on 
your workstation, press the W key while you click the thumbnail to open the image in WebScope rather than 
ImageScope.) The Annotations window in summary view displays. (If the window does not look like the example 
below, click the Summary button to return the Annotations window to the summary view):

(If you have chosen clinical view, you cannot see the detailed Annotations window and the Details button does not 
display. See “Using Clinical View” on page 12 for more on this view.)

The algorithm appropriate for this type of slide is listed in the drop-down box. You can select another algorithm if 
you wish from that box.

From this window you can draw annotations to identify areas to analyze and run the analysis, as described in the 
next section.

Drawing Annotations and Analysis

To draw an annotation to analyze:

1.	 With the algorithm that you want to use shown in the drop-down list, use the pen or rectangle drawing tools to 
draw the areas of the eSlide you want to analyze.

To navigate between annotations you have drawn, use the numbered buttons or arrow keys. 
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As you draw annotations with the analysis algorithm shown in the drop-down box, the buttons at the top of the 
window display a number for each annotation. 

 

From the Annotations - Summary View window, you can do the following: 

`` To center an annotation in the window, click the numbered button that corresponds to the annotation.

`` Move between the annotations by using the arrow keys or by clicking the numbered button.

`` To delete the selected annotation, click . To delete all annotations, click .

`` To hide the selected annotation, click .

`` To save the annotations to eSlide Manager, go to the File menu and select Save Annotations.

2.	 To analyze the current eSlide with the algorithm shown in the drop-down box:

a.	 Select the annotation drawn around the area you want to analyze and select Selected Annotation. Or, if you 
want to analyze the entire area shown in the window, select Current Screen.

b.	 Click Run Analysis. As the analysis runs, you see progress information (for example, Loading 80%).
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When the analysis is complete, you see the results:

For more information on using the Annotations summary view window, see the eIHC User’s Guide.

Incremental Processing

The eIHC analysis applications are incremental algorithms, which means that as you add new regions and click Run 
Analysis on the Annotations window, only the new regions are analyzed. Any time you click Run Analysis again, all 
analysis results are updated.

Incremental processing is useful when a pathologist draws and analyzes a single region, and after reviewing the analysis 
results wants to select additional regions to analyze. As annotation regions are added or deleted, the analysis results are 
updated accordingly.

If you delete a region, WebScope will automatically re-run the analysis to update the summary analysis results that included 
that region. However, adding regions may make the analysis results incorrect until you re-run the analysis.

Enabling/Disabling Pre-processing
Some algorithms can pre-process the image to annotate regions for you (usually to detect possible tumor areas), and the 
algorithm will then analyze just those regions. If you are using such an algorithm but want to select tumor regions manually, 
click the pre-processing button  on the Annotations summary view window to temporarily turn off this feature. (The 
button is only enabled when you are using an algorithm with the pre-processing feature.) When disabled, the button looks 
like this: . Click the button again to turn on pre-processing.

Plotting Results

If you are using an algorithm macro to analyze an eSlide that has result plotting enabled, any plots selected by that macro 
automatically appear in separate windows when the analysis is complete.
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This chapter discusses how to analyze eSlides using WebScope.

Using image analysis algorithms to analyze eSlides gives you a way to automatically examine, count, and find structures of 
interest. Using an algorithm to look for this information provides precise, quantitative data that is accurate and repeatable.

About eIHC Quick Analysis
This chapter discusses using the WebScope Annotations window detailed view to view analysis results, which provides a 
general-purpose solution for research analysis. WebScope provides another way to select tumor regions and analyze them 
that is optimized for a clinical workflow—see “Chapter 4: eIHC Quick Analysis” on page 22.

Preparing for Analysis
Before you can run an image analysis algorithm, a macro for that algorithm must exist. (A macro contains the algorithm 
parameter settings.) Creating a macro involves opening the eSlide in ImageScope, selecting an image analysis algorithm, 
fine-tuning the algorithm parameters to suit your application, and saving the macro on eSlide Manager. This procedure is 
typically done by the eSlide Manager administrator. For details on this process, see the Aperio ePathology Image Analysis 
User’s Guide or the ImageScope User’s Guide.

You can run analysis on an entire eSlide or on one or more 
annotated regions. If you want to analyze a portion of the eSlide, 
before the analysis you will want to select the areas of interest 
by using the WebScope drawing tools (see “Chapter 3: Using 
Annotations” on page 15 for details on using these tools).

For example, in this IHC ER eSlide, we selected an area of heavy 
staining by using the rectangle drawing tool, but used the negative 
pen tool to exclude areas within that rectangle of background tissue 
that we don’t want to analyze.

5 Analyzing eSlides
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Running an Analysis
To analyze the eSlide in WebScope:

1.	 Open the eSlide in WebScope, as discussed in “Chapter 1: Overview” on page 5.

2.	 Click  on the WebScope main toolbar to open the Annotations window. 

3.	 To select an area of the eSlide to analyze, use the annotation drawing tools (see the section above for an example). 
If you have more than one layer of annotations, select the Annotations layer that contains the annotations you 
want to use for analysis.

4.	 Click  on the WebScope main toolbar to open the Algorithm Server Job window:

a.	 Click one of the algorithm macros listed in the window to select it.

b.	 If you want a visual representation of the analysis on the eSlide image in addition to the quantitative results, 
select the Generate Markup Image check box.

c.	 If you want to analyze the entire image of the eSlide in the WebScope window, select Entire Image under 
Region of Analysis. To analyze only the annotated areas, select Selected Annotation.

d.	 Click Analyze.

WebScope displays a status message during analysis, and lets you know when the analysis is complete.

Analysis Results

When the analysis is complete, quantitative results appear in a new layer in the Annotations window. 
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For example:

If you requested a mark-up image, the eSlide image also contains a visual representation of the analysis results. (For 
information on the meaning of the different pseudo-colors used in the mark-up, see the user’s guide for the algorithm you 
are using.)
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Plotting Analysis Results
If the algorithm macro used to analyze the eSlide has data plots enabled, you can click the Plots button to view the 
results in graphical form. (Not all algorithms allow result plotting. When creating the algorithm macro, view the input 
parameters to see if plotting is available with that algorithm.)

Click the Plots button  to open a window that lists the available plots.

Click a link in the Plots window to open the corresponding plot chart. For example, click the Nuclear Size link in the Plots 
window to see the Nuclear Size Plot.
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Symbols
ÌÌ The following symbols may appear on your product label or in this user’s guide:

Manufacturer

Date of manufacture (year - month - day)

European Union Authorized Representative

In vitro diagnostic device

Serial number

Relative humidity range

Storage temperature range

Electronic and electrical equipment waste disposal

The exclamation point within an equilateral triangle is intended to alert you to the presence of important operating
and maintenance (servicing) instructions.
Le point d’exclamation dans un triangle équilatéral vise à avertir l’utilisateur qu’il s’agit d’instructions d’utilisation
et d’entretien importantes.

The lightning flash with arrowhead symbol within an equilateral triangle is intended to alert you to the presence of
uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient magnitude to constitute a
risk of electric shock to persons.
Le symbole de l’éclair avec la pointe de flèche dans un triangle équilatéral vise à avertir l’utilisateur que le boîtier
du produit présente une « tension dangereuse » non isolée d’une amplitude suffisante pour constituer un risque
d’électrocution.

The flat surface with waves symbol within an equilateral triangle is intended to alert you to the presence of hot
surfaces which could cause burn damage.
Le symbole d’une surface plane et de vagues dans un triangle équilatéral vise à avertir l’utilisateur de la présence
de surfaces chaudes qui peuvent causer des brûlures.

The UV lamp within an equilateral triangle is intended to alert you to the presence of UV light within the
product’s enclosure that may be of sufficient magnitude to constitute a risk to the operator.
La lampe UV dans un triangle équilatéral vise à avertir l’utilisateur de la présence de rayonnement
UV dans le boîtier du produit qui peut être d’une amplitude suffisante pour constituer un risque pour
l’utilisateur.
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